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                        Abstract     The fi nal step in the problem-solving process is to evaluate the effective-
ness of the intervention. One way to make data more easily interpretable is to dis-
play it visually. By graphing data both providers and caregivers are able to see 
changes in the behavior measured and decisions about interventions can be made. 
Graphs can be created through drawing by hand or using computer programs, such 
as Microsoft Excel.  

  Keywords     Baseline data   •   Intervention data   •    X -axis   •    Y -axis   •   Phase change line   
•   Continuing an intervention   •   Modifying an intervention   •   Discontinuing an 
intervention  

           Once progress monitoring data has been collected for a minimum of three different 
points, this data should be plotted on a graph. Visual displays provide a simple way 
to quickly interpret progress monitoring data and determine whether or not an inter-
vention has been effective. Graphs require little time to create once you understand 
the basic components. Graphs can be created by hand or through computer pro-
grams such as Microsoft Excel. In the following sections, both graphing methods 
will be described. 

 Important Graphing Terms

•     Baseline Data : Baseline data refers to the data collected about a behavior prior 
to intervention. When one looks at data of a behavior before and after interven-
tion implementation, they are able to infer about the intervention’s impact. (A in 
graph below)  

•    Intervention Data : Intervention data refers to the data collected after an interven-
tion has been put into place. Intervention data allows one to see if the behavior 
has changed after intervention implementation. (B in graph below)  
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•    X - Axis : The horizontal axis of the graph represents the time the data was 
collected. This axis could be divided into minutes, hours, days, weeks, and so on. 
For example, if the number of hours a child sleeps each night were being mea-
sured, the  X -Axis would represent night of the week. (C in graph)  

•    Y - Axis : The vertical axis of the graph represents the instances of a behavior. This 
axis could be divided into number of times the behavior occurs, number of min-
utes, and so forth. For example, if one was measuring the number of hours a child 
sleeps each night, the  Y -Axis would represent number of hours of sleep. (D in 
graph)  

•    Phase Change Line : A vertical, dashed line that separates baseline data from 
Intervention data. (E in graph below)    

 See the graph below for an illustration of the graphing terms.
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       Directions for Graphing by Hand 

 Emily’s parents began implementing an intervention to increase the amount of food 
Emily consumes. To evaluate the effectiveness of their intervention, Emily’s parents have 
counted the number of bites of food Emily eats each night at dinner for the past week. 
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This included 3 days before they actually implemented the intervention (the baseline) 
and 5 points once they started implementing the intervention (progress monitoring). 
The next step is to graph this data.

 Baseline data  Intervention data 

 Friday  Saturday  Sunday  Monday  Tuesday  Wednesday  Thursday  Friday 
 4  4  4  4  7  6  8  9 

   Step 1: See Appendix D. This is the type of graph on which data can be plotted.

     

    Step 2: Label the horizontal  X -axis with the days of the week   .
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 Directions for Graphing by Hand
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    Step 3: Label the vertical  Y -axis with the behavior and ensure that the scale is appropriate 
for that behavior (e.g., consider whether or not the scale begins at zero and goes up 
to or beyond the maximum number of behaviors expected).
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    Step 4: Plot the data provided above. Be sure not to connect Baseline and Intervention 
data.

     

9 Evaluating Outcomes



153

    Step 5: Draw a vertical, dotted line between the Baseline and Intervention data to 
separate them. Then label each.

     

    All fi nished! Now you have a graph of your data.  

    Computer Graphing 

 Microsoft Excel is one example of a computer program that makes graphing easy 
and produces professional-looking graphs. Some people may initially fi nd Excel to 
be overwhelming, but once you get the hang of it, graphing with Excel is much 
easier (and more professional looking) than graphing by hand. Included in this text 
are instructions for graphing with Excel 2007 and Excel 2011.  

    Graphing with Excel 2007 

     1.    Enter your data in columns as shown below. In column A, enter when the 
data was collected. This will be your  X -Axis. In Column B, enter your base-
line data for the days you collected it. In Column C, enter your intervention data.

 Graphing with Excel 2007
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        2.    Highlight the data by left-clicking on the top left cell, and dragging down and 
to the right, until all the data are highlighted. Click on the Insert tab, and then 
click on “Line” in the Charts subsection. Select the “Line with markers” option, 
which is the fi rst option in the second row.
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        3.    You should now have a graph that looks like this one. You will notice a new trio 
of tabs that appears at the top of the window on the right, colored light green 
and categorized as Chart Tools, which we will use to modify your graph.

     

 Graphing with Excel 2007
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        4.    Now let’s format the axes titles. We will do the  X -axis title fi rst. Select the 
“Layout” tab (in Chart Tools) and click the “Axis Titles” submenu. Select “Title 
Below Axis” for the  X -axis title.
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        5.    Now let’s format the  Y -axis title. Select the  Y -axis from the same “Axis Title” 
submenu, then click “Rotated Title” to display your title along the  Y -axis line. 
This function will put the  Y -axis title along the vertical bar of the graph.

     

        6.    Click on the “Axis Title” boxes to enter the desired titles for the  X  and  Y  axes.

     

 Graphing with Excel 2007
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        7.    The fi nal label on the graph will be the title. Under the “Layout” tab (within 
Chart Tools), select “Chart Title” and select the placement of the Title for the 
graph. The title can then be fi lled in by clicking on the Chart Title box in the 
graph.
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        8.    Notice that the maximum  Y -axis value is 18. However, if our goal or aim will 
exceed 18, we need to extend the scale. We can do this by right-clicking on the 
 Y -axis itself. This will bring up a menu with the option “Format Axis.”

     

 Graphing with Excel 2007
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        9.    In the “Format Axis” toolbox, change Maximum from “Auto” to “Fixed” and 
make the maximum value 30.0. Click “Close.”
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        10.    Now, right-click within the graph sub-window, but OUTSIDE of the data point 
area. This will bring up a slightly different window, within which you will see 
the option “Move Chart.”

     

 Graphing with Excel 2007
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        11.    In the “Move Chart” window, select the option “New sheet” and type the title 
of your graph. Now click OK.
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        12.    Your graph should now look like the one below. You can access the data you 
typed in before by clicking on “Sheet 1” at the bottom left of the Excel 
window.

     

 Graphing with Excel 2007
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        13.    Now we are going to add the phase change line to separate the Baseline from 
the Intervention data. Under the Insert tab, select Shapes, and pick the fi rst line 
shown under the Lines submenu.
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        14.    You will notice that your pointer has changed into a small cross-hair. Move this 
new pointer to a point that is between the Baseline and Intervention data. Now, 
hold down the Shift key on your keyboard, then left-click and drag the pointer 
vertically downward to the  X -axis. Release the mouse button and  then  the 
SHIFT key. (Holding the Shift key keeps the line straight.)

     

            Graphing with Excel 2011 

     1.    Enter your data in columns as shown below. In column A, enter when the data 
was collected. This will be the  X -axis. In column B, enter your baseline data for 
the days you collected it. In column C, enter the data collected while the inter-
vention was in place.

 Graphing with Excel 2011
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        2.    Highlight all the information by clicking on the top left cell and holding the 
mouse while dragging to the bottom right. Make sure all the data are high-
lighted. Then click on the “Charts” tab at the top and select “Line.” The pre-
ferred form of Line graph to use is the “Marked Line.”
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        3.    Excel will generate a graph to the right of your data. There are also two new 
tabs: “Chart Layout” and “Format” which contain many functions to changes 
your graph.

     

 Graphing with Excel 2011
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        4.    The next step is to label your graph so other people can understand what the 
data represent. First click on the “Chart Layout” tab and then on “Axis Titles.” 
Select the “Horizontal Axis” option and then “Title Below Axis.” This will 
make a text box appear that will allow you to label the graph with the word 
“Date” in Step 6.

     

9 Evaluating Outcomes



169

        5.    Next is the  Y -axis title. Click “Axis Titles” again but select “Vertical Axis Title” 
and then select “Rotated Title.” A second text box will appear along your 
 Y -axis. You will fi ll this in on the next step.

     

 Graphing with Excel 2011
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        6.    Click on both “Axis Title” boxes and enter the desired titles for the  X  and  Y  
axes. For this graph, the  X -axis will get the word “Date” and the  Y -axis will be 
labeled with “Minutes Tantrumming.”
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        7.    The fi nal label on the graph will be the title. Under the “Chart Layout” tab, 
select “Chart Title” and then click on “Title Above Chart.” This will create the 
fi nal text box or you to type in the title for this graph. In the example below, the 
graph will be called “Jacob’s Tantrums Length.”

     

 Graphing with Excel 2011
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        8.    Notice that the  Y -axis goes up to 140 min, but our highest value is 115. To make 
the graph fi t the data better, the  Y -axis has to be rescaled. To do this, right click 
when the mouse is over the  Y -axis. Mac users can hold the “control” button and 
click the mouse to do this. In the pop-up box that appears, select “Format Axis.”
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        9.    In the Format Axis box that pops up, select “Scale” and then change the 
“Maximum” to refl ect the value you want for the top portion of the  Y -axis. Then 
select “OK.” For this graph, the maximum value will be 120.

     

 Graphing with Excel 2011
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        10.    Now the graph will be moved so that it can be examined in more detail. To do 
this, right click on any area outside of the graph lines. A good place is the white 
space over the “Baseline” word in the Legend. Clicking here will bring up a 
new menu window where you can select “Move Chart.”

     

9 Evaluating Outcomes



175

        11.    Clicking on “Move Chart” opens a new box. Select “New sheet” and then type 
in the name of your graph. Then click “OK.”

     

 Graphing with Excel 2011
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        12.    You will get a graph on a new sheet. It should look like the one below. You can 
access the data you typed in before by clicking on “Sheet 1” at the bottom left 
of the Excel window.
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        13.    The last element to add is the phase change line to separate the Baseline and 
Intervention phases. At the top of the screen, select “Insert” (between View and 
Format) and highlight the word “Picture.” In the new menu that opened, click 
on “Shape.” This will open a new window with options for shapes.

     

        14.    In the new window, select “Lines and Connectors.” This will bring up several 
options of lines you can choose from to make your Phase Change Line.

     

 Graphing with Excel 2011
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        15.    After selecting a straight line, you will notice that your cursor has changed into 
a small cross-hair. Move the cross-hair to a point on the  X -axis that is between 
the Baseline and Intervention data. Hold down the “Shift” key on the key board, 
click your mouse, and drag the mouse upward. When you reach the top of your 
graph, let go of the mouse and  then  the “Shift” key. Holding down the “Shift” 
key while dragging keeps the line straight.

     

        Following these steps will produce a basic graph in Excel. All versions of 
Microsoft Excel have many features, allowing a user to change the colors of lines, 
the shape of markers on a line, adding trendlines, etc. The best way to learn about 
additional functions in Excel is to explore. When you have time, click into different 
areas and try different features. There is no need to worry about messing up your 
graph. If something happens to your graph that you did not want to happen, click 
“Undo” and then keep trying. Just be sure to save you work often as you are going.  

    Guidelines for Evaluating Outcomes 

 Once you have fi ve or more progress monitoring data points graphed, you can use 
your graph to begin evaluating how well your intervention is working. One of three 
different decisions can be made: (1) continue the intervention; (2) modify the inter-
vention; or (3) discontinue the intervention. 
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    Continue the Intervention 

      

     Interventions should continue when they are working, meaning that the desired 
behavior is increasing (and the challenging behavior is decreasing). When this is 
the case, the trend of your graph may look like the one above (when graphing the 
desired behavior). In this situation, continue implementing your intervention.   

    Modify the Intervention 

      

     Interventions should be modifi ed when they are working but are working too slowly. 
Although some interventions work, they may not be working as fast as we would 
like. Therefore, the intensity of the intervention should be increased, such as increas-
ing the amount of time spent on the intervention.   

    Discontinue the Intervention 

      

    Interventions that have no effect or are detrimental should be discontinued. These 
 progress monitoring  lines will have a negative slope or no change at all. In this situa-
tion, you should go back to the problem solving process and revise your intervention.   

 Guidelines for Evaluating Outcomes
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    Evaluating Outcomes Examples 

 Below are four different examples of graphed progress monitoring data and the 
decisions made about each. Keep in mind that the goal of this intervention was to 
increase the number of bites of food Emily eats to nine. Ideally, the  progress moni-
toring  line should increase above zero.

     

    The progress monitoring line is completely fl at. This fl at line, or slope of zero, 
indicates that the number of bites of food Emily is eating is not changing and thus 
not increasing toward the goal of nine bites. Therefore, it appears that this  interven-
tion is not working . The intervention should be discontinued and a new one should 
be developed by recycling through the problem solving process. You may also want 
to check to make sure that the intervention is actually being implemented.
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    The progress monitoring line on this graph has a negative slope and is moving 
 toward  zero, meaning that the number of bites of food Emily is eating is decreasing. 
This line indicates that the intervention is having a detrimental impact on Emily’s 
behavior and  the intervention is not working . This intervention should be discontin-
ued and a new one should be developed.

     

    This progress monitoring line has a positive slope and is slowly moving  away  
from zero, meaning that the number of bites is increasing toward the goal of nine 
bites, but slowly.  This intervention is working, but not as quickly as we would like . 
This intervention should be adjusted to increase the intensity of the intervention.
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    This progress monitoring line has a positive slope and is moving  away  from zero, 
meaning that the number of bites is increasing toward the goal of nine bites.  This 
intervention is working . The intervention should continue as should progress 
monitoring.  

    Conclusions 

 Progress monitoring data makes it possible to determine whether or not the inter-
vention is successful, and can be used to make decisions about the intervention. 
Graphing data provides a visual display which aids in answering questions as to 
whether the intervention is working or not, and if it is working as effi ciently as 
intended. Graphs can be completed manually or by using programs such as Microsoft 
Excel.  

    Assess Your Knowledge 

  Use the questions below to assess your knowledge of the information presented in 
this chapter. Answers appear after the last question. 

    1.    A child is referred to you for frequent head banging. On which axis would you 
plot head banging?

    a.     X -axis   
   b.     Y -axis   
   c.     XY -axis   
   d.    Not enough information to tell       

   2.    What is the primary purpose of collecting baseline data?

    a.    To put it on your graph   
   b.    To be able to tell if your intervention was effective   
   c.    To show what data you are collecting   
   d.    To speed up when you can implement your intervention       

   3.    When drawing a graph in Excel, which step comes fi rst?

    a.    Label your phases   
   b.    Format the  X- axis   
   c.    Enter the raw data in columns   
   d.    Draw the phase change line       

   4.    What is the purpose of the phase change line?

    a.    To separate the baseline and intervention data   
   b.    To show the child’s progress during baseline   
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   c.    To show the child’s progress during the intervention phase   
   d.    To label your graph       

   5.    If your graph looks like the graph below, what should be your next step?

     

      a.    Continue your intervention   
   b.    Stop the intervention   
   c.    Change the intervention   
   d.    Start over with the intervention    

      6.    Data are collected on the number of nights where the child has remained dry 
through the night (for toileting). On which axis should you place the days of 
the week?

    a.     X -axis   
   b.     Y -axis   
   c.     XY -axis   
   d.    Not enough information to tell       

   7.    If your graph looks like the graph below, what should be your next step?

     

 Assess Your Knowledge
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      a.    Continue your intervention   
   b.    Stop the intervention   
   c.    Change the intervention   
   d.    Start over with the intervention    

      8.    What is the last step in graphing with Excel?

    a.    Label your  x - and  y -axes   
   b.    Create the scale for your data   
   c.    Enter your data in the spreadsheet   
   d.    Inserting the phase change line.       

   9.    When graphing by hand, which points are not connected?

    a.    The baseline points   
   b.    The last baseline and fi rst intervention data points   
   c.    The intervention points       

   10.    You are implementing an intervention to increase the number of words a 
26-month-old child is saying per hour. Your baseline data shows that the child 
is saying approximately 1 word per hour. You implement an intervention and 
track the child’s progress. Immediately following the intervention, the child 
begins using 5 words per hour, and then 10 the next day, and so on. What should 
you do next?

    a.    Continue with the intervention   
   b.    Modify the intervention   
   c.    Discontinue the intervention   
   d.    Change the intervention        

   Assess Your Knowledge Answers  
 1) b 2) b 3) c 4) a 5) a 6) a 7) b 8) d 9) b 10) a    
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